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General Information

The OPEN SYSTEMS Accounting Software (OSAS�) product line consists of 
several accounting applications. Each application addresses a different phase
your financial operations; together, they form a powerful accounting solution to
your daily and periodic accounting needs.

The ODBC Kit

The OSAS ODBC Kit provides users with a way to access their OSAS data thro
any ODBC-compliant productivity package. The ODBC Kit includes an ODBC
driver for Windows, the data dictionaries for the OSAS data files, utilities for 
maintaining the data dictionaries and some sample reports in Microsoft� Excel, 
Microsoft Access� and Crystal Reports� for Windows.

The Report Applets

Since the release of the ODBC Kit, OSAS users have been discovering the po
of these popular productivity packages to analyze their accounting data. The 
Report Applets provide a series of pre-built Microsoft Excel PivotTables� to help 
you get the most from your accounting data. 

These tables are provided for each of the major data files in each application. 
manual includes instructions for loading and using these spreadsheets to sort
analyze your data. With a little practice, you can easily create similar PivotTab
or modify the ones provided to customize them to your exact needs.
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Purchase Order Data Files

You use the Purchase Order system to account for orders you place with vend
Purchase Order encompasses the capabilities of Accounts Payable; you can r
purchases you made from vendors and orders you have not yet paid. Purchas
Order lends its tracking capabilities to other applications associated with track
assets (Inventory for example).

PO Data Files

The Purchase Order Report Applet contains several spreadsheets that report 
information from the OSAS Purchase Order data files. The PivotTables in the 
Report Applet are based on these data files:

POORxxx and POOHxxx

The Open Order Detail and Header files store records for orders and returns b
you post them. If Purchase Order is interfaced with Inventory, these functions 
update serialized and nonserialized item balances and costs in Inventory. The
POOHxxx file stores header and totals information; the POORxxx file stores li
item information. 

Data from the Open Order Detail file is used in the PO Order Detail 
(PODETORD.XLS) PivotTable. Data from the Open Order Header file is 
displayed on the PO Transaction Summary (POTRNSUM.XLS) and PO Tax 
Report (POTRNTAX.XLS) PivotTables. 

POPQxxx

The Purchase Requisition file stores records for orders generated in the Gene
Orders function. In the Generate Orders function the records whose orders yo
generate are sent to the Open Order files. The records whose orders you do n
generate are kept in this file indefinitely. The data stored in this file is the basis
the PO Purchase Requisitions (POPURREQ.XLS) PivotTable.
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PORIxxx, PORGxxx and PORTxxx

The Receipts and Invoices files store the receipts and invoices you entered fo
orders and the debit memos you applied to returns. The PORGxxx file stores 
item information about goods received; the PORIxxx file stores line-item 
information about invoices applied; the PORTxxx file stores totals information.

Data from the PORIxxx file appears in the PO Invoice Detail (POINVDET.XLS
PivotTable. 

Data from the PORGxxx file is displayed on the PO Receipt of Goods 
(PORECPT.XLS) PivotTable.

Data from the PORTxxx file is the basis for the PO Invoice Totals 
(POINVTOT.XLS) PivotTable.
PO Report Applet User’s Manual1-6
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Introduction to PivotTables

A Microsoft Excel PivotTable is an interactive table that quickly summarizes, o
cross-tabulates, large amounts of data. You can rotate its rows and columns to
different summaries of the source data, filter the data by displaying different pa
or display the details for areas of interest.

A PivotTable contains fields, each of which summarizes multiple rows of 
information from the source data. By dragging a field button to another part of 
PivotTable, you can view your data in different ways. For example, you can vie
any field either down the rows or across the columns.

The PivotTable summarizes data by using a summary function, such as Sum, 
Count, or Average. You can include subtotals and grand totals automatically, o
your own formulas by adding calculated fields and items.

In the Purchase Order Report Applet, several PivotTables are provided based o
data in the OSAS data files. The PivotTable is updated through the ODBC driv

The next section includes a tutorial for setting up and modifying PivotTables in
Excel.
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Creating Microsoft Excel PivotTables

Read this section for an exercise in creating a PivotTable using the ODBC Kit 
Microsoft Excel 97. If you require more information about Microsoft Excel, 
consult the Microsoft Excel User’s Guide or Online Help.

Before you can create this report, complete these tasks:

• Install and set up the ODBC Kit.

• Install and set up the BASIS ODBC drivers.

• Install Microsoft Excel 97 and Microsoft Query 97.

Note

This section includes instructions for using Microsoft Query with Microsoft 
Excel. If necessary, you can install Microsoft Query from the Microsoft Office 
media. You may also need to create a shortcut to Query manually.
PO Report Applet User’s Manual 1-9
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Building a Query For a PivotTable

1. Start Microsoft Query.

2. Under the File menu, select New.

The Choose Data Source screen appears.
PO Report Applet User’s Manual1-10
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3. Select <New Data Source>, and click OK .

The Create New Data Source screen appears.

4. Enter a name you want to give the data source in field 1. You can use the 
source again.

5. Select the BASIS ODBC Driver in field 2.

6. Click Connect. 

The BASIS ODBC Driver Data Source Setup box appears.

7. Enter the file path and name of the CONFIG.TPM file you set up from wit
the OSAS ODBC software in the Database Configuration field, or select 
Browse and locate the file.
PO Report Applet User’s Manual 1-11



Creating Microsoft Excel PivotTables Introduction

ck 
 

ise, 
u 

st of 
If you have already built the shadow dictionary, click on the Advanced 
button, and check the options for No Shadow Dictionary Consistency Che
and Fast Connect to improve performance. See online help for additional
information about the options that come with the Advanced button.

8. Click OK  to connect to the data source.

You are returned to the Create New Data Source screen.

9. Select a table in field 4 if you want to select a default table source; otherw
leave field 4 blank and select any table when you develop the query. (If yo
select a table, the list of tables always starts at that table; otherwise the li
tables starts at the beginning of the list.)

The Choose Data Source box appears.

10. Select the data source you set up in the previous steps.
PO Report Applet User’s Manual1-12
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The Choose Columns screen appears.

11. Select a table you want to use in your Excel spreadsheet. For this examp
start with one table and add a second table later. Select the SOTH table, s
the columns for the spreadsheet, and click Next >.

The Filter Data box appears. 

Use the Filter Data dialog box to select specific records from the table. In
most cases, you do not need to choose anything in the Filter Data dialog 
For example, to filter out credit memos, select the field named 
TRANSACTION_TYPE, select does not equal, and then enter 4 for a value. 
(TRANSACTION_TYPE 4 is a credit memo.) 
PO Report Applet User’s Manual 1-13
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12. Click Next >. 

The Sort Order box appears.

Use the Sort Order dialog box to select how the data is sorted. For examp
select a field in Sort by and check Ascending or Descending. Select more
fields and orders for hierarchical sorts. For now, don’t enter any sort fields

13. Click Finish. You are returned to the Microsoft Query screen.
PO Report Applet User’s Manual1-14
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The data in your query is displayed. You can delete columns by selecting
column and pressing the Delete key. You can also add a column by double-
clicking on the field name (in the SOTH file).

Note

NOTE: You can also select which fields you want in your query in step 6 abo
Instead of selecting the entire table, you can click the + box next to the table 
want and select the given fields from the list.

14. Select the following fields:

• BATCH_ID
• ORDER_NUMBER
• TRANSACTION_TYPE
• INVOICE_NUMBER
• INVOICE_DATE
• CUSTOMER_ID
• SUBTOTAL
• SALES_TAX
• TOTAL_COST

15. Select Table from the main menu, and choose Add tables.

The Add Table dialog box appears.
PO Report Applet User’s Manual 1-15
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16. A list of all the tables is displayed. Select the SOTD table, and click Close.

Joining Tables

17. Locate BATCH_ID in the SOTD and SOTH tables; then click and hold the
left mouse button down on BATCH_ID in the SOTH table

18. Drag the field over to the BATCH_ID field in the SOTD table and release 
mouse button. 

A line appears between the two BATCH_ID fields, joining the two fields.

19. Follow steps 17 through 18 with the ORDER_NUMBER field.

NOTE: You may get the following message. For now, click Yes to ignore the 
message and join the fields together.

20. Select the following fields from the SOTD table:

• ENTRY_NUMBER
• UNIT_COST_COMPNT
• UNIT_PRICE
• ORDERED_QTY
• SHIPPED_QTY_SELL
• BACKORDERED_QTY.

21. Select Save from the File menu to save the query.
PO Report Applet User’s Manual1-16



Creating Microsoft Excel PivotTablesIntroduction
Using the Query in Microsoft Excel

1. Start Excel and open a new worksheet.

2. Select the Data menu; then select PivotTable Report.
PO Report Applet User’s Manual 1-17
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The PivotTable Wizard appears. 

3. In step 1 of the Wizard, a list of options is displayed where you can choos
your data source to be used in your PivotTable. Select External Data Source, 
and click Next >.

The PivotTable Wizard Step 2 dialog box appears. 

4. In step 2 of the Wizard, click Get Data.
PO Report Applet User’s Manual1-18
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The Choose Data Source box from Microsoft Query appears. 

5. Click the Queries tab, and select the query you saved under Microsoft Que

The Choose Columns box under Query appears. 
PO Report Applet User’s Manual 1-19
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6. Click Next >. The query columns are displayed.

7. Click Next > to pass by Filter Data  and Sort Order options.

The Query Wizard - Finish dialog box appears.

8. Select Return Data to Microsoft Excel, and click Finish.

You are returned to the PivotTable Wizard Step 2 dialog box. 

9. Click Next >. 
PO Report Applet User’s Manual1-20
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The PivotTable Wizard Step 3 dialog box appears. 

The selected fields and four areas—Page, Row, Column, and Data—to put 
fields are displayed. Drag and drop the fields to use in this report into the 
respective areas. (To display the full field name, hold the cursor on the bu
and a tool tip displays the full field name.)

10. Drag and drop the following fields:

• TRANSACTION_TYPE into Page

• INVOICE_NUMBER, INVOICE_DATE, and ENTRY_NUM into Row

• BATCH_ID into Column 

• ORDERED_QTY, SHIPPED_QTY_SELL, UNIT_COST_COMPNT 
and UNIT_PRICE into Data.
PO Report Applet User’s Manual 1-21



Creating Microsoft Excel PivotTables Introduction

ata 

et or 
The fields are displayed on the screen. Numeric fields dropped into the D
section become summary fields. 

11. Click Next >. 

The PivotTable Wizard Step 4 dialog box appears.

12. The last step lets you create the PivotTable either in the existing workshe
in a different worksheet. Accept the given options and click Finish.
PO Report Applet User’s Manual1-22
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The PivotTable is displayed. 

Highlight rows and columns to shift them around. To display only invoices
change Transaction Type from All  to 3. Change it to 4 and credit memos are 
displayed. Totals per type are also displayed. 

Adding a Calculated Field

You can also add new fields, like profit, to the data area. To add profit to the d
area, follow these steps:

1. Highlight the last row in your data area, Sum of UNIT_PRICE, right-click, 
and select Insert.
PO Report Applet User’s Manual 1-23
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The Insert Calculated Field dialog box appears.

2. Enter the following information about the inserted field:

• Enter Profit Dollars in the Name field.

• Enter =(SHIPPED_QTY_SELL* UNIT_PRICE) - 
( SHIPPED_QTY_SELL* UNIT_COST_COMPNT)  in the Formula 
field.

3. Click Add.
PO Report Applet User’s Manual1-24
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4. Click OK .

The PivotTable is displayed with the Sum of Profit Dollars field.
PO Report Applet User’s Manual 1-25
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Changing Field Properties

You can also change the properties of the fields in the table. For example, to 
remove the subtotals from the INVOICE_DATE field:

1. Place your mouse cursor on the INVOICE_DATE column heading, right-cl
and select Field... from the menu. 

The PivotTable Field dialog box appears:

You can use the PivotTable Field dialog box to change the field name, its 
orientation on the PivotTable, its display mask, subtotalling options and so

2. To shut of the subtotals, select None under Subtotals and click OK.
PO Report Applet User’s Manual1-26
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The PivotTable is redisplayed reflecting your changes:
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Moving Fields and Sorting Data

You can dramatically change the appearance of the table by moving the fields
around. Fields appear on the PivotTable as gray blocks with the field name on
them. To move any field, simply drag it to a new destination.

You can change your PivotTable by moving fields in these ways:

Changing the Selection Fields

If you want to be able to limit the data in the table, you can make any field in th
table part of the selection criteria by moving it to the Page area.

For example, to select a specific batch for this table rather than displaying all t
batches across the table columns as they are in our sample table, follow these

1. Position the mouse cursor over the BATCH_ID field, press and hold the le
mouse button.

As you drag the BATCH_ID field around the table, the cursor changes to 
show where you can drop it. If the cursor looks like a block with an X over it, 
you will remove the field from the table by dropping it there.

2. Drag the BATCH_ID field to the left of the TRANSACTION_TYPE field an
drop it there.
PO Report Applet User’s Manual1-28
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The change appears immediately:
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Changing the Column Data

You can change the data that appears in the columns in the table by dragging
fields or data block to the column heading area.

For example, to show the quantity, price, cost and profit information in our tab
across the columns instead of in the data block as they now appear, drag the Data 
field above the Total column heading and drop it there.

The change appears immediately:
PO Report Applet User’s Manual1-30
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Changing the Data Sort

To change the order in which the data is displayed, you can simply change the
fields around. 

For example, our PivotTable is sorted by Invoice Number. To sort it by Invoice
Date instead, click and drag the INVOICE_DATE field to the left of the 
INVOICE_NUMBER field.

The data is sorted by Invoice Date and is redisplayed:

You can also drag the selection fields from the Page area to the Row area to so
data by those fields.
PO Report Applet User’s Manual 1-31
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More About Using PivotTables 

Feel free to experiment with the orientation of the fields on this sample report.
you become more familiar with the tables and how to use them, you can enjoy
benefits of viewing your data in new and different ways.

For more information about PivotTables, see the Microsoft Excel documentatio
online help.
PO Report Applet User’s Manual1-32
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Installation

PO Report Applet User’s Manual
You can put the Purchase Order ODBC Report Applet on your system by insta
it through Resource Manager. The installation process is described in this sec

The Purchase Order Report Applet needs a minimum of 111 kilobytes (111KB)
installation. You must also have installed Purchase Order and the ODBC Kit o
your system, and the ODBC drivers on the Windows workstation. 

Installing the Report Applet

Use the Install Application function on the Resource Manager Installation men
install the report applet. You must install the Accounts Payable and Purchase O
applications before you install this report applet. 

The installation will treat the report applet as though you are reinstalling Purch
Order. This is normal behavior.

Note

You must install the applet for Accounts Payable in order to access the vendo
and other master file and historical information you enter.

When you install the report applet, Resource Manager copies the PivotTables t
directory where your Purchase Order programs are stored. You must have acc
this directory from your Windows machine to access the tables in Microsoft Ex

2

PO Report Applet User’s Manual 2-1



Installation

ata 
C 
ect 

es 

ny 
u 

py 
orts 

g 

t 
nd in 

the 
The CONFIG.TPM File

When you install the ODBC Kit, you specify the location of the data files and d
dictionaries in a file called CONFIG.TPM. You can build this file using the ODB
Kit functions. You can store this file in any directory, but the report applets exp
the file to be located in the C:\WINDOWS directory.

If your CONFIG.TPM file is stored in a different directory, you have three choic
for using the PivotTables supplied with the report applet:

1. Move the CONFIG.TPM file to the C:\WINDOWS directory and change a
Data Sources you have set up and any ODBC reports or spreadsheets yo
have already set up to use the CONFIG.TPM in its new location.

2. Copy the CONFIG.TPM file to the C:\WINDOWS directory and leave a co
in its current location. You do not need to change any Data Sources or rep
you have set up, but you need to make any changes in both files.

3. Change the PivotTables provided with this report applet to use the 
CONFIG.TPM file in its current location.  You can find instructions for doin
this below.

If you choose methods 1 or 2 above, you can load the PivotTables in Microsof
Excel and begin using them with your data by using the Refresh Data comma
Excel.

If you choose option 3, follow the instructions below to point the PivotTable to 
correct CONFIG.TPM file.
PO Report Applet User’s Manual2-2
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Using a Different CONFIG.TPM

If you store your CONFIG.TPM file in a location other than the C:\WINDOWS 
directory, you will see this message when you attempt to refresh the data in an
PivotTable included with this report applet:

When you click on OK, the BASIS ODBC Driver Data Source Setup dialog box
appears:

To specify the location of your CONFIG.TPM file, click Browse and select the f
from the location screen:
PO Report Applet User’s Manual 2-3
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When you select the file, the final dialog appears:

When you click on OK, the PivotTable is updated with your accounting data.  

Report Applet PivotTables

Use the descriptions of the PivotTables in chapter 3 to work with your account
data.
PO Report Applet User’s Manual2-4
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PO Order Detail

File Name

PODETORD.XLS

Description

The PO Order Detail PivotTable uses the data in the Open Order Detail (POO
file to display detailed information about the purchase orders you have on file.

The data is sorted by Transaction Number, Item ID and Location ID, but you c
easily change the sort order, or add the Order Status and Vendor ID to the sor

Active Fields

Default Field Type Field

Page Order Status
Vendor ID

Row Transaction Number
Item ID
Location ID

Column Order Quantity
Received Quantity
Invoiced Quantity
Unit Cost
Extended Order Cost
PO Report Applet User’s Manual 3-3



PO Order Detail PO PivotTables
PO Order Detail PivotTable Sample
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PO Invoice Detail

File Name

POINVDET.XLS

Description

The PO Invoice Detail PivotTable uses the data in the Invoice Detail (PORIx) f
to display detailed information about the invoices you’ve received from your 
vendors and applied to your purchase orders.

The data is sorted by Transaction Number, Entry Number and Sequence Num
but you can easily change the sort order or add the GL Period, Invoice Status
Invoice Source to the sort.

Active Fields

Default Field Type Field

Page GL Period
Invoice Status
Invoice Source

Row Transaction Number
Entry Number
Sequence Number

Column Quantity
Unit Cost
Extended Cost
PO Report Applet User’s Manual 3-5
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PO Invoice Detail PivotTable Sample
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PO Invoice Totals

File Name

POINVTOT.XLS

Description

The PO Invoice Totals PivotTable uses the data in the Invoice Header (PORTx
to display summarized totals for the invoices you have received from your ven
and applied to your orders.

The PO Invoice Totals PivotTable consists of these related spreadsheets: Cur
Totals and Posted Totals. You can change between these sheets by selecting 
appropriate tab at the bottom of the current sheet.

The information is sorted by Transaction Number, Sequence Number, Invoice
Number and Invoice Date, but you can change the sort easily to include the Inv
Status or Invoice Source.
PO Report Applet User’s Manual 3-7
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PO Invoice Totals–Current Totals Sheet

Active Fields

PO Invoice Totals–Current Totals PivotTable Sample

Default Field Type Field

Page Invoice Status
Invoice Source

Row Transaction Number
Sequence Number
Invoice Number
Invoice Date

Column Taxable and Nontaxable Subtotals
Tax
Freight
Miscellaneous Charges
Discount
Prepaid Amount
PO Report Applet User’s Manual3-8
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PO Invoice Totals–Posted Totals Sheet

Active Fields

PO Invoice Totals–Posted Totals PivotTable Sample

Default Field Type Field

Page Invoice Status
Invoice Source

Row Transaction Number
Sequence Number
Invoice Number
Invoice Date

Column Taxable and Nontaxable Subtotals
Tax
Freight
Miscellaneous Charges
Discount
Prepaid Amount
PO Report Applet User’s Manual 3-9
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PO Purchase Requisitions

File Name

POPURREQ.XLS

Description

The PO Purchase Requisitions PivotTable uses the data in the Purchase 
Requisitions (POPQx) file to display detailed information about the items that h
been requisitioned, but not yet placed in a purchase order.

The report is sorted by Item ID and Location ID, but you can easily change the
order of the sort, or add the Source Application and Vendor ID to the sort.

Active Fields

Default Field Type Field

Page Source Application
Vendor ID

Row Item ID
Location ID

Column Quantity Ordered
Unit Cost
Extended Cost
PO Report Applet User’s Manual 3-11



PO Purchase Requisitions PO PivotTables
PO Purchase Requisitions PivotTable Sample
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PO Receipt of Goods

File Name

PORECPT.XLS

Description

The PO Receipt of Goods PivotTable uses the data in the Receipts Detail (PO
file to display detailed information about the goods you’ve received against yo
current purchase orders.

The report is sorted by Transaction Number, Entry Number and Sequence Num
but you can easily change the sort order to include the GL Period, Receipt Stat
Source Code.

Active Fields

Default Field Type Field

Page GL Period
Receipt Status
Source

Row Transaction Number
Entry Number
Sequence Number

Column Quantity
Unit Cost
Extended Cost
PO Report Applet User’s Manual 3-13
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PO Receipt of Goods PivotTable Sample
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PO Transaction Summary

File Name

POTRNSUM.XLS

Description

The PO Transaction Summary PivotTable uses the data in the Open Order He
(POOHx) file to display summarized totals for the open purchase orders you h
on file.

The PO Transaction Summary PivotTable consists of these related spreadshe
Invoice Totals, Posted Totals and Memo Totals. You can change between thes
sheets by selecting the appropriate tab at the bottom of the current sheet.

The information is sorted by Transaction Number and Vendor ID, but you can 
change the sort easily to include the Order Status.
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PO Transaction Summary–Invoice Totals Sheet

Active Fields

PO Transaction Summary–Invoice Totals PivotTable Sample

Default Field Type Field

Page Order Status

Row Transaction Number
Vendor ID

Column Taxable and Nontaxable Subtotals
Tax
Freight
Miscellaneous Charges
Discount
Prepaid Amount
PO Report Applet User’s Manual3-16



PO Transaction SummaryPO PivotTables
PO Transaction Summary–Posted Totals Sheet

Active Fields

PO Transaction Summary–Posted Totals PivotTable Sample

Default Field Type Field

Page Order Status

Row Transaction Number
Vendor ID

Column Taxable and Nontaxable Subtotals
Tax
Freight
Miscellaneous Charges
Discount
Prepaid Amount
PO Report Applet User’s Manual 3-17



PO Transaction Summary PO PivotTables
PO Transaction Summary–Memo Totals Sheet

Active Fields

PO Transaction Summary–Memo Totals PivotTable Sample

Default Field Type Field

Page Order Status

Row Transaction Number
Vendor ID

Column Taxable and Nontaxable Subtotals
Tax
Freight
Miscellaneous Charges
Discount
Prepaid Amount
PO Report Applet User’s Manual3-18
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File Name

POTRNTAX.XLS

Description

The PO Tax Report PivotTable uses the data in the Open Order Header (POO
file to display summarized sales tax breakdowns for your purchase orders.

The report is sorted by Vendor ID and Location ID, but you can easily change 
sort order or include the Order Status in the sort.

Active Fields

Default Field Type Field

Page Order Status

Row Vendor ID
Location ID

Column Level 1 Tax and Taxable Subtotal
Level 2 Tax and Taxable Subtotal
Level 3 Tax and Taxable Subtotal
Level 4 Tax and Taxable Subtotal
Level 5 Tax and Taxable Subtotal
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PO Tax Report PivotTable Sample
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